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Abstract 

 

 
Substantial increase in automobile theft figures internationally calls on for a robust 

automobile security system which can offer real time monitoring and control rather than just 

intimating about theft. In this paper, an embedded system is designed in such a way that, 

when the owner gets intimation about intrusion he can remotely start or stop the engine and 

also obtain the image of intruder. This is achieved by interfacing GSM (Global system for 

mobile communication system) with ARDUINO. An accelerometer acts as a sensor to 

intimate towing. 
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Chapter 1 

Introduction 
 

 

1.1 INTRODUCTION OF PROJECT 

 
In today’s world, security is a very important aspect for the working professionals. It is the 

company’s utmost responsibility to take care of its employee’s safety. In the last few 

decades, India has progressed at such an enormous rate that many companies have strongly 

established themselves here. These companies bring a huge amount of workforce with them. 

Arranging transportation to such a huge mass is a cumbersome task involving lots of 

intricacies. 

 

Generally this conveyance facility is arranged through the local transport vendors on a yearly 

contract basis. Due to recently happened mishaps such as burglary, rape cases etc., the 

employee safety, esp. for the women employees, has become a number one priority for most 

of the companies. Even though the companies take good precautions to ensure that its 

employees are safe, there are some serious loop holes in the existing system. Firstly there is 

no full proof mechanism to track the outsiders. The drivers of the cabs cannot be trusted. 

There exists no system to communicate and track the vehicle in danger on most of the 

vehicles. In order to deal with these problems, we have come up with the innovative solution 

of “GSM Vehicle Tracking and Employee Security System”. This system will detect the 

outsiders as well as locate the cabs through RFID mechanisms.  

 

 

We have also incorporated an emergency button for employee’s safety. Wherever an 

employee finds himself/herself in trouble, he/she will press the button and an SMS will be 

sent to the nearest police station and the company’s monitoring unit, so that they will take the 

necessary action. In this project we proposed GSM based system for Vehicle Tracking and 

Employee Security System. It consists of car unit, emergency button and company unit. Car 

unit is placed inside the car. When the car picks up the employee; he/she needs to swap the 

RF card. The micro controller matches the RF card no. with its database records and sends 

the employee’s id, cab id & the cab position co-ordinates to the company unit via GSM 

module.  

 



2  

 

Emergency button is a part of car unit. There are three to four emergency buttons in the car. 

These buttons are placed at such position so that employee can access them easily i.e. near 

the door unlocking handle. If employee finds himself/herself in a problem, he/she will press 

the button. Micro controller will detect the action & sends a signal to the GSM which will 

coordinate with to the company unit and police. Micro controller will also send a signal to 

the relay which will turn off the car ignition & stop the car. Company unit consists of GSM 

modem, RS232 cable & computer. The GSM Modem will receive the message through 

GSM. This message will then be transferred to the computer through the serial port. The 

employee name, employee id & cab position coordinates (longitude and latitude) get 

displayed on computer. 

 

 

 

1.2 Objectives 

The main objective of this project is- 

 To Study of GSM Technology. 

 To design a Vehicle Security System Using GSM Technology. 

 To Construct a Vehicle Location Tracking System. 

 

 

 

1.3 Methodology 

• Creating an idea for Vehicle Security System Using GSM Technology And drawing 

and listed of components/materials to know which components/materials need to 

construct it.  

• Collecting the all components/materials construct the system. 

• Finally, we constructed this system & checked it finally that working very well. 
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Chapter-2  

2.1 Literature Review 

Hari Sankar et al., [1] recommend a full response to each collision with vehicle identification 

and rescue vehicle. When a car collides with a car identification device in a car, the entire 

server sends a nearby ambulance with the car to the collision. An Android device using an 

ambulance will help drivers quickly and securely collect area details. Automation of collision 

by recognizing and sending the vehicle, along with training the ambulance driver. 

 

Nicky Kattukkaran and others. The relevant accelerator in the car recognizes the inclination of 

the car and the heartbeat sensor in the user's physics recognizes the abnormality of the heartbeat 

and understands the importance of the car. Thus, the devices select the selector via Bluetooth 

and send the laptop to a smartphone connected to the accelerator and heart rate sensor. The 

Android device on the mobile phone sends text content material text messages to nearby clinics 

and friends. In addition, the application shares the actual location of the time-saving hospital. 

 

Adnan bin Fayez et al., [3] have developed a fully-fledged Android system that can detect the 

situation unexpectedly and send emergency warning messages to nearby police stations and 

fitness centers. The device is equipped with an external pressure sensor that removes the 

external pressure of the body. It measures speed and switching points with GPS and accelerator 

sensors, respectively, on Android phones. By checking the conditions, this software program is 

helpful in reducing false alarm fees. 

 

D Selvathi et al. The prevention area includes Smart Helmet. If these two preconditions are not 

met, the rails will no longer be on the engine. The microcontroller controls the transmission 

capability and fires as a result of the retreat. In addition, the component can detect the collision 

with a car in any area and assess the collision of the car with the predefined numbers with the 

GSM module. The microcontroller continuously archives all the parameters of the car to 

prevent and acknowledge the collision of the car. 

 

Chunxiao Liao, et .al introduced the "Mobile Shore-Based Smart Traffic Accident Detection 

System" in 2017. The article presents a framework for smart car crashes based on the nearby 

mobile Edge computer-based, idle and recyclable and car-certified proof. Our framework uses 

basic mobile phones to increase speed and speed, and to identify images that display error-
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prone scenes, to recognize computerized error-detection if false positives occur, and to advise 

environmental factors and divisions, such as clinics and transportation departments. 

 

Sanjana. K.R, et. In 2015, the Emergency Services Center introduced the "Smart Traffic Lights 

with Automatic Rescue System." They used a sensor to create a frame that automatically 

identifies street accidents, advising them to use GSM to manage crises and close them by 

family members. It is fully computerized, using Google's guides to locate the fault, control 

traffic lights and reach the emergency center in a timely manner. This framework will be viable 

in countries with a large population, such as India. 

 
 
 

 

2.2 Block Diagram 
 

 
 

 

 

 

Figure 2.1: Block Diagram 
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2.3 Schematic Diagram 
 

 

 
 

Figure 2.2: Schematic Diagram 

 

2.4 ARDUINO NANO 

Arduino is open-source electronics prototyping platform based on flexible, easy-to-use 

hardware and software. It's intended for artists, designers, hobbyists, and anyone interested in 

creating interactive objects or environments. Arduino can sense the environment by receiving 

input from a variety of sensors and can affect its surroundings by controlling Lights, motors, 

and other actuators. 

 

Figure 2.3: Arduino Nano  
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The micro controller on the board is programmed using the Arduino programming language 

(based on Wiring) and the Arduino development environment (based on Processing). Arduino 

projects can be stand-alone or they can communicate with software on running on a computer 

(e.g. Flash, Processing, Maxims’). Arduino Nano is a surface mount breadboard embedded 

version with integrated USB. It is a small, complete, and breadboard friendly component. It has 

everything that Decimal/ Duemilanove has (electrically) with more analog input pins and 

onboard +5V AREF jumper. Physically, it is missing power jack. The Nano can automatically 

sense and switch to the higher potential source of power.  

 

Figure 2.4: Arduino Nano Schematic Diagram 

 

 

 

Nano’s got the breadboard-ability of the Boarding and the Minibus with smaller footprint than 

either, so users have more breadboard space. It’s got a pin layout that works well with the Mini 

or the Basic Stamp (TX, RX, ATN, and GND on one top, power and ground on the other). This 

new version 3.0 comes with ATMEGA328 which offer more programming and data memory 

space. It has two layers. That make it easier to hack and more affordable. One of the best 

features of Arduino Nano is, it’s easy to use, compact and also small. 
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Figure 2.5: How Arduino Nano looks like 

 

 

Specifications of Arduino: 

 Micro controller: Atmel ATmega328  

 Operating Voltage (logic level): 5 V  

 Input Voltage (recommended): 7-12 V  

 Input Voltage (limits): 6-20 V  

 Digital I/O Pins: 14 (of which 6 provide PWM output)  

 Analog Input Pins: 8  

 DC Current per I/O Pin: 40 mA  

 Flash Memory: 32 KB (of which 2KB used by boot loader)  

 SRAM : 2 KB  

Features:  

 Automatic reset during program download  

 Power OK blue LED  

 Green (TX), red (RX) and orange (L) LED  

 Auto sensing/switching power input  
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 Small mini-B USB for programming and serial monitor  

 ICSP header for direct program download  

 Standard 0.1 spacing DIP (breadboard friendly)  

 Manual reset switch  

 

 

 

Micro controller IC ATmega328p 

 

Figure 2.6: Micro controller IC AT mega 328p 
 

 

 

The high-performance Microchip Pico Power 8-bit AVR RISC-based microcontroller combines 

32KB ISP flash memory with read-while-write capabilities, 1024B EEPROM, 2KB SRAM, 23 

general purpose I/O lines, 32 general purpose working registers, three flexible timer/counters 

with compare modes, internal and external interrupts, serial programmable USART, a byte-

oriented 2-wire serial interface, SPI serial port, a 6-channel 10-bit A/D converter (8-channels in 

TQFP and QFN/MLF packages), programmable watchdog timer with internal oscillator, and 

five software selectable power saving modes. The device operates between 1.8-5.5 volts. By 

executing powerful instructions in a single clock cycle, the device achieves throughputs 

approaching 1 MIPS per MHz, balancing power consumption and processing speed.  
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2.5 Battery 

A lithium battery is the first battery to use a metal lithium anode. This type of battery is also 

called a lithium metal battery. They differ from other batteries in charging density and high unit 

cost. 

 

Figure 2.7: 3.7V Battery 

Product Specification 

 

Output Voltage 3.7 V 

Product Quality Lithium-ion 

Battery Capacity 2200mAh 

Weight 45g 

Model Number ICR 18650 

 

2.6 DC Gear Motor 

Gear motors are mechanisms that adjust the speed of electric motors, leading them to operate at 

a certain speed. They are composed of a series of gears that make up a kinematic chain, 

working on a set of rotary parts.  

Their main purpose is to allow the reduction from an initial high speed to a lower one without 

negatively affecting the mechanism. In addition to this adjustment, a gear motor is in charge of 

adjusting the mechanical power of a system.  
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Figure 2.8: Gear Motor 

 

Mechanical components that complement gear motors 

Gear motors are composed of an electric motor and gears, which form the kinematic chain – the 

fundamental component of the gear ratio. 

 

Kinematic chain 

A motor’s speed reducer is composed of a speed reducer and its gears.  

This speed reducer is basically a variable speed drive that allows for the speed to be reduced 

and increased at the output shaft. 

Gears 

Gears are toothed wheels made of metal or plastic (and new materials with each passing day) 

that transmit motion when meshing with each other.  

They are defined by their number of teeth and their size. In addition, they may have straight-cut 

or helical teeth.  

 

Motors 

The five types of motors that see the most use in gear motors are: 

 Brushed motors, with brushes normally made out of carbon. They are bidirectional and 

may be used with DC or AC. They have a service life of about 3000 hours. 

 Asynchronous motors, which are brushless single-direction motors. They are highly 

limited. 

 Synchronous brushless motors, which may be single-direction or bidirectional. They 

have a constant speed if the frequency of the power source is stable. 

 Brushless DC motors that use a driver and can attain high speeds. 

 Stepper DC brushless motors. They can be positioned with an average precision of 7.5º. 
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2.7 L293D Motor Driver IC 
 

The L293D is a popular 16-Pin Motor Driver IC. As the name suggests it is mainly used to 

drive motors. A single L293D IC is capable of running two DC motors at the same time; also 

the direction of these two motors can be controlled independently. 

 

 
 

Figure 2.9: Motor driver IC L293D 
 

 

Working Process: 

 
L293D IC is a typical Motor Driver IC which allows the DC motor to drive on any direction. 

This IC consists of 16-pins which are used to control a set of two DC motors instantaneously in 

any direction. It means, by using a L293D IC we can control two DC motors. 

Features 

 Can be used to run Two DC motors with the same IC. 

 Speed and Direction control is possible 

 Motor voltage Vcc2 (Vs): 4.5V to 36V 

 Maximum Peak motor current: 1.2A 

 Maximum Continuous Motor Current: 600mA 

 Supply Voltage to Vcc1(vss): 4.5V to 7V 

 Transition time: 300ns (at 5Vand 24V) 

 Automatic Thermal shutdown is available 
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L293D Pin Configuration 

 

Pin Number Pin Name Description 

1  Enable 1,2 
This pin enables the input pin Input 1(2) and Input 

2(7) 

2 Input 1 
Directly controls the Output 1 pin. Controlled by 

digital circuits 

3 Output 1 Connected to one end of  Motor 1 

4 Ground Ground pins are connected to ground of circuit (0V) 

5 Ground Ground pins are connected to ground of circuit (0V) 

6 Output 2 Connected to another end of  Motor 1 

7 Input 2 
Directly controls the Output 2 pin. Controlled by 

digital circuits 

8 Vcc2 (Vs) 
Connected to Voltage pin for running motors (4.5V 

to 36V) 

9 Enable 3,4 
This pin enables the input pin Input 3(10) and Input 

4(15) 

10 Input 3 
Directly controls the Output 3 pin. Controlled by 

digital circuits 

11 Output 3 Connected to one end of Motor 2 

12 Ground Ground pins are connected to ground of circuit (0V) 

13 Ground Ground pins are connected to ground of circuit (0V) 

14 Output 4 Connected to another end of Motor 2 

15 Input 4 
Directly controls the Output 4 pin. Controlled by 

digital circuits 

16 Vcc2 (Vss) Connected to +5V to enable IC function 

 

Table 01: Motor Driver Pinout 
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Use of a L293D Motor Driver IC: 

Using this L293D motor driver IC is very simple. The IC works on the principle of Half H-

Bridge, let us not go too deep into what H-Bridge means, but for now just know that H bridge 

is a set up which is used to run motors both in clock wise and anti clockwise direction. As said 

earlier this IC is capable of running two motors at the any direction at the same time, the circuit 

to achieve the same is shown below. 

 

Figure 2.10: L293D circuit Diagram 

 

All the Ground pins should be grounded. There are two power pins for this IC, one is the Vss 

(Vcc1) which provides the voltage for the IC to work, this must be connected to +5V. The other 

is Vss (Vcc2) which provides voltage for the motors to run, based on the specification of your 

motor you can connect this pin to anywhere between 4.5V to 36V, here I have connected to 

+12V. 

The Enable pins (Enable 1,2 and Enable  3,4)  are used to Enable Input pins for Motor 1 and 

Motor 2 respectively. Since in most cases we will be using both the motors both the pins are 

held high by default by connecting to +5V supply. The input pins Input 1,2 are used to control 

the motor 1 and Input pins 3,4 are used to control the Motor 2. The input pins are connected to 

the any Digital circuit or microcontroller to control the speed and direction of the motor. 
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Applications 

 Used to drive high current Motors using Digital Circuits 

 Can be used to drive Stepper motors 

 High current LED’s can be driven 

 Relay Driver module (Latching Relay is possible) 

 

2.8 5V Regulator IC 

 
Voltage sources in a circuit may have fluctuations resulting in not providing fixed voltage 

outputs. A voltage regulator IC maintains the output voltage at a constant value. 7805 IC, a 

member of 78xx series of fixed linear voltage regulators used to maintain such fluctuations, is a 

popular voltage regulator integrated circuit (IC). The xx in 78xx indicates the output voltage it 

provides. 7805 IC provides +5 volts regulated power supply with provisions to add a heat sink.  

 

7805 IC Rating  

 Input voltage range 7V- 35V  

 Current rating Ic = 1A  

 Output voltage range VMax=5.2V , VMin=4.8V 

 

 

 

Figure 2.11: 5V Regulator IC 

The main mechanism of this regulator IC is regulated a fixed voltage of this project. This IC 

supply 5V 5Amp voltage/current for safety of this demo project. 
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2.9 Transistor 

  
Specifications: 

 Bipolar Transistor, npn, 45v, to-92 

 Transistor Polarity: NPN 

 Collector Emitter Voltage V(br)ceo: 45V 

 Transition Frequency Typ ft: 300MHz 

 Power Dissipation Pd: 625mW 

 DC Collector Current: 100mA 

 DC Current Gain hFE: 150 

 Straight-lead housing  

 

Figure 2.12: BC 547 

 

 

Figure 2.13: Transistor Symbols 

The difference between “P” and “N” doped semiconductors, the functional characteristics of a 

PN (diode) junction, and the meanings of the terms “reverse biased” and “forward biased.” If 

these concepts are unclear to you, it is best to refer to earlier chapters in this book before 
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proceeding with this one.A bipolar transistor consists of a three-layer “sandwich” of doped 

(extrinsic) semiconductor materials, either P-N-P in Fig below a(b) or N-P-N at (d). Each 

layer forming the transistor has a specific name, and each layer is provided with a wire contact 

for connection to a circuit. The schematic symbols are shown in Fig below (a) and (d). 

BJT transistor: (a) PNP schematic symbol, (b) physical layout (c) NPN symbol, (d) layout. 

The functional difference between a PNP transistor and an NPN transistor is the proper 

biasing (polarity) of the junctions when operating. For any given state of operation, the 

current directions and voltage polarities for each kind of transistor are exactly opposite each 

other.Bipolar transistors work as current-controlled current regulators. In other words, 

transistors restrict the amount of current passed according to a smaller, controlling current. 

The main current that is controlled goes from collector to emitter, or from emitter to collector, 

depending on the type of transistor it is (PNP or NPN, respectively).  

 

Figure 2,14: NPN & PNP Transistor Symbol 

Small Base-Emitter current controls large Collector-Emitter current flowing against emitter 

arrow. Bipolar transistors are called bipolar because the main flow of electrons through them 

takes place in two types of semiconductor material: P and N, as the main current go from 

emitter to collector (or vice versa). In other words, two types of charge carriers—electrons and 

holes—comprise this main current through the transistor. 

As you can see, the controlling current and the controlled current always mesh together through 

the emitter wire, and their electrons always flow against the direction of the transistor’s arrow. 

This is the first and foremost rule in the use of transistors: all currents must be going in the 

proper directions for the device to work as a current regulator. The small, controlling current is 

usually referred to simply as the base current because it is the only current that goes through the 
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base wire of the transistor. Conversely, the large, controlled current is referred to as the 

collector current because it is the only current that goes through the collector wire. The emitter 

current is the sum of the base and collector currents, in compliance with Kirchhoff’s Current 

Law. No current through the base of the transistor, shuts it off like an open switch and prevents 

current through the collector. A base current, turns the transistor on like a closed switch and 

allows a proportional amount of current through the collector. Collector current is primarily 

limited by the base current, regardless of the amount of voltage available to push it. 

 
 

2.10 GSM Module 

At the heart of the module is a SIM800L GSM cellular chip from Sim Com. The operating 

voltage of the chip is from 3.4V to 4.4V, which makes it an ideal candidate for direct LiPo 

battery supply. This makes it a good choice for embedding into projects without a lot of space. 

 

 

Figure 2.15: GSM Module 

 

 

 

All the necessary data pins of SIM800L GSM chip are broken out to a 0.1″ pitch headers. This 

includes pins required for communication with a microcontroller over UART. The module 

supports baud rate from 1200bps to 115200bps with Auto-Baud detection. 

The module needs an external antenna to connect to a network. The module usually comes with 

a Helical Antenna and solders directly to NET pin on PCB. The board also has a U.FL 

connector facility in case you want to keep the antenna away from the board. 
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Figure 2.16: GSM Module Introducing  

 

There’s a SIM socket on the back! Any activated, 2G micro SIM card would work perfectly. 

Correct direction for inserting SIM card is normally engraved on the surface of the SIM socket. 

This module measures only 1 inch² but packs a surprising amount of features into its little 

frame. Some of them are listed below: 

 Supports Quad-band: GSM850, EGSM900, DCS1800 and PCS1900 

 Connect onto any global GSM network with any 2G SIM 

 Make and receive voice calls using an external 8Ω speaker & electret microphone 

 Send and receive SMS messages 

 Send and receive GPRS data (TCP/IP, HTTP, etc.) 

 Scan and receive FM radio broadcasts 

 Transmit Power: 

o Class 4 (2W) for GSM850 

o Class 1 (1W) for DCS1800 

 Serial-based AT Command Set 

 FL connectors for cell antennae 

 Accepts Micro SIM Card 
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SIM800L GSM Module Pinout 

The SIM800L module has total 12 pins that interface it to the outside world. The connections 

are as follows: 

 

Figure 2.17: GSM Module Pinout 

 

NET is a pin where you can solder Helical Antenna provided along with the module. 

VCC supplies power for the module. This can be anywhere from 3.4V to 4.4 volts. Remember 

connecting it to 5V pin will likely destroy your module! It doesn’t even run on 3.3 V! An 

external power source like Li-Po battery or DC-DC buck converters rated 3.7V 2A would 

work. 

RST (Reset) is a hard reset pin. If you absolutely got the module in a bad space, pull this pin 

low for 100ms to perform a hard reset. 

 

RxD (Receiver) pin is used for serial communication. 

TxD (Transmitter) pin is used for serial communication. 

GND is the Ground Pin and needs to be connected to GND pin on the Arduino. 

RING pin acts as a Ring Indicator. It is basically the ‘interrupt’ out pin from the module. It is 

by default high and will pulse low for 120ms when a call is received. It can also be configured 

to pulse when an SMS is received. 

DTR pin activates/deactivates sleep mode. Pulling it HIGH will put module in sleep mode, 

disabling serial communication. Pulling it LOW will wake the module up. 

MIC± is a differential microphone input. The two microphone pins can be connected directly to 

these pins. 

SPK± is a differential speaker interface. The two pins of a speaker can be tied directly to these 

two pins. 
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2.11 ESP-32 Camera 
 

The ESP32-CAM is a full-featured microcontroller that also has an integrated video camera and 

micro SD card socket.  It’s inexpensive and easy to use, and is perfect for IoT devices requiring 

a camera with advanced functions like image tracking and recognition.  

 

 

Figure 2.18: ESP-32 CAM Pin out diagram 

 

ESP32-CAM Specifications 

The ESP32-CAM is based upon the ESP32-S module, so it shares the same specifications.  

It has the following features: 

 802.11b/g/n Wi-Fi 

 Bluetooth 4.2 with BLE 

 UART, SPI, I2C and PWM interfaces 

 Clock speed up to 160 MHz 

 Computing power up to 600 DMIPS 

 520 KB SRAM plus 4 MB PSRAM 

 Supports Wi-Fi Image Upload 

 Multiple Sleep modes 

 Firmware Over the Air (FOTA) upgrades possible 

 9 GPIO ports 

 Built-in Flash LED 
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Chapter-3 System Model 

 

 

3.1 To Build up the Model 

This paper gives design, and implementation of a newly proposed methodology system, that 

uses the popular social communication media, mobile as a value added service for traditional 

overseer system. The proposed methodology is focused on improving the technology used to 

improve the security of the car. In this security of car can be further increased by adding an 

accelerometer sensor which helps in towing purpose. In the previous system security lock and 

alarm is implemented in a car. If a burglar can break open the lock, then it becomes easy for 

the burglar to steal the car. And in old security system if the car is stolen then it is out of the 

owner control.  Here, we are implementing an ignition kill switch which can be closed only 

by owner’s message. So, the car wouldn’t start unless owner sends the message. There is a 

spy camera in the car which helps in getting the photo of intruder. In this proposed system the 

door pin sensor which is in the vehicle acts as sensor. This data will be continuously 

transmitted to the Arduino microcontroller from the door pin sensor. If the door gets opened 

then Arduino sends message to the owner through GSM module. If the owner sends e0 then 

the ignition kill switch gets closed and engine starts. If the owner sends e1 then the spy cam- 

era clicks the images of the intruder. 

 

 

3.2 Working Principle 

In our project we have a power source that is battery. In this project we have used an Ardudino 

Nano for operate this system.. Here we use a   GSM module will help the send a text in rescue 

team.  If the car gate want to open someone unknown, it will immediately send a text to the 

phone via GSM. It will also send a notification if anyone try to ignite engine with out driver. 

Then also  send a text to the phone via GSM. This will save the lives of the passengers in the 

car by rescuing them very quickly.  
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3.3  Complete Project Prototype Image :  

 

 

 
 

Figure 3.1:Devlopment-7 Vehicle Security system with GSM Module
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Chapter-4 Coding Design 

 
4.1 Arduino Software 

  

A digital microcontroller unit called the Arduino Nano can be configured with the Arduino 

software IDE. No need to install any other software than Arduino. First, Select "Arduino Nano 

from Tools, the Board menu (according to the microcontroller on our board). The used IC 

called ATmega328 in Arduino Nano is pre-heated with a boot loader that allows us to upload 

new code to it without use. external hardware editor. 

 

Communication takes place using the original STK500 protocol (reference, C header files). We 

can also bypass the loader and program the microcontroller via the ICSP (In Circuit Serial 

Programming) header. The ATmega16U2 firmware source code (or 8U2 on rev1 and rev2 

boards) is available. The ATmega16U2 / 8U2 is loaded with a DFU loader that can be 

activated: 

 

 

 

 

 

 

 

 

 

 

 

 

 

 

Figure 4.1: Arduino IDE Interface 
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Writing Sketches 

Programs written using Arduino Software (IDE) are called sketches. These sketches are written 

in the text editor and are saved with the file extension .ino. The editor has features for 

cutting/pasting and for searching/replacing text. The message area gives feedback while saving 

and exporting and also displays errors. The console displays text output by the Arduino 

Software (IDE), including complete error messages and other information. The bottom 

righthand corner of the window displays the configured board and serial port. The toolbar 

buttons allow you to verify and upload programs, create, open, and save sketches, and open the 

serial monitor. 

NB: Versions of the Arduino Software (IDE) prior to 1.0 saved sketches with the extension 

.pde. It is possible to open these files with version 1.0, you will be prompted to save the sketch 

with the .ino extension on save. 

 

Find in Reference 

This is the only interactive function of the Help menu: it directly selects the relevant page in the 

local copy of the Reference for the function or command under the cursor. 

 

Sketchbook 

The Arduino Software (IDE) uses the concept of a sketchbook: a standard place to store your 

programs (or sketches). The sketches in your sketchbook can be opened from the File > 

Sketchbook menu or from the Open button on the toolbar. The first time you run the Arduino 

software, it will automatically create a directory for your sketchbook. You can view or change 

the location of the sketchbook location from with the Preferences dialog. 

Beginning with version 1.0, files are saved with a .ino file extension. Previous versions use the 

.pde extension. You may still open .pde named files in version 1.0 and later, the software will 

automatically rename the extension to .ino. 

 

Tabs, Multiple Files, and Compilation 

Allows you to manage sketches with more than one file (each of which appears in its own tab). 

These can be normal Arduino code files (no visible extension), C files (.c extension), C++ files 

(.cpp), or header files (.h). 
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Uploading 

Before uploading your sketch, you need to select the correct items from the Tools > Board and 

Tools > Port menus. The boards are described below. On the Mac, the serial port is probably 

something like /dev/tty.usbmodem241 (for an Uno or Mega2560 or Leonardo) or 

/dev/tty.usbserial-1B1 (for a Duemilanove or earlier USB board), or 

/dev/tty.USA19QW1b1P1.1 (for a serial board connected with a Keyspan USB-to-Serial 

adapter). On Windows, it's probably COM1 or COM2 (for a serial board) or COM4, COM5, 

COM7, or higher (for a USB board) - to find out, you look for USB serial device in the ports 

section of the Windows Device Manager. On Linux, it should be /dev/ttyACMx , /dev/ttyUSBx 

or similar. Once you've selected the correct serial port and board, press the upload button in the 

toolbar or select the Upload item from the Sketch menu. Current Arduino boards will reset 

automatically and begin the upload. With older boards (pre-Diecimila) that lack auto-reset, 

you'll need to press the reset button on the board just before starting the upload. On most 

boards, you'll see the RX and TX LEDs blink as the sketch is uploaded. The Arduino Software 

(IDE) will display a message when the upload is complete, or show an error. 

When you upload a sketch, you're using the Arduino bootloader, a small program that has been 

loaded on to the microcontroller on your board. It allows you to upload code without using any 

additional hardware. The bootloader is active for a few seconds when the board resets; then it 

starts whichever sketch was most recently uploaded to the microcontroller. The bootloader will 

blink the on-board (pin 13) LED when it starts (i.e. when the board resets). 

 

Libraries 

Libraries provide extra functionality for use in sketches, e.g. working with hardware or 

manipulating data. To use a library in a sketch, select it from the Sketch > Import Library 

menu. This will insert one or more #include statements at the top of the sketch and compile the 

library with your sketch. Because libraries are uploaded to the board with your sketch, they 

increase the amount of space it takes up. If a sketch no longer needs a library, simply delete its 

#include statements from the top of your code. 

There is a list of libraries in the reference. Some libraries are included with the Arduino 

software. Others can be downloaded from a variety of sources or through the Library Manager. 

Starting with version 1.0.5 of the IDE, you do can import a library from a zip file and use it in 

an open sketch. See these instructions for installing a third-party library. 
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Third-Party Hardware 

Support for third-party hardware can be added to the hardware directory of your sketchbook 

directory. Platforms installed there may include board definitions (which appear in the board 

menu), core libraries, bootloaders, and programmer definitions. To install, create the hardware 

directory, then unzip the third-party platform into its own sub-directory. (Don't use "arduino" as 

the sub-directory name or you'll override the built-in Arduino platform.) To uninstall, simply 

delete its directory. 

For details on creating packages for third-party hardware, see the Arduino IDE 1.5 3rd party 

Hardware specification. 

 

 
4.2 Proteus Software 

 
The program is mainly used by electronic design engineers and technicians to print schematic 

and electronic printers. The SPICE mixed mode Simulation was first integrated into Proteus in 

1996, and then the microcontroller simulation was introduced into Proteus in 1998. In 2002 and 

2006, a car-based automation regime was added, with the addition of 3D Board Visualization, 

another major product development. Recently, a special IDE rating was added in 2011 and 

MCAD import / export was introduced in 2015. High-speed design support was added in 2017.  

 

 

Figure 4.2: Proteus Software Interface 



27  

Chapter-5 

Conclusion 
 

 

 

5.1 Conclusion: 

We have successfully developed and implemented a vehicle tracking system that gives 

feedback information of the location of stolen vehicle using GSM technology. It is user 

friendly, easily installable, easily accessible and can be used for various other purposes. The 

system is not limited to find the location of the target but also calculates the distance travelled 

between two stations. It can also be applied for better management of fleet with a return of 

large profit, better scheduling or route planning to enable large job schedule. If this project is 

properly implemented it will improve safety, reduce vehicle loss due to theft, increase 

productivity, reduce diversion of routes by transport company’s drivers. We are still working 

on the possibility of improving on the system to give SMS feedback to the vehicle owner when 

an accident occurs. This will help to reduce the delay in evacuation of accident victims to 

hospital and reduce the chances of losing life. 

 

 

5.2 Future Scope: 

In future its can be developed with more featured. 

  

 Can be added more sensor with this system. 

 Can be added accident prevention & massage alerting system. 
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